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 ABOUT THIS GUIDE

Copyright
No part of this document may be reproduced or transmitted in any form or by 

any means, electronic or mechanical, including photocopying and recording, 

for any purpose without the express written consent of SilhouetteFX, LLC.

Copyright © SilhouetteFX, LLC 2017. All Rights Reserved

July 10, 2017

About Us
SilhouetteFX brings together the unbeatable combination of superior software 

designers and visual effects veterans. Add an Academy Award for Scientific 

and Technical Achievement, 3 Emmy Awards and experience in creating visual 

effects for hundreds of feature films, commercials and television shows and you 

have a recipe for success.
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 WHAT’S NEW IN 6.1

Features

Auto Paint > Paint History Custom In/Out Enhancement
To provide a faster way to set custom in/out points in the Auto Paint > Paint 

History, arrows were added to each numeric field which enter the currently 

parked frame when clicked.

Copy Alpha to RGBA Shape Preference
A Copy Alpha to RGBA shape preference was added.

MultiFrame Range Improvement
When using MultiFrame and adjusting which keyframes were affected, there 

was no feedback to show if you were just tweaking the in/out point or sliding the 

whole range. Now, the MultiFrame range is displayed in the status bar while it 

is being edited.

Nuke 9+ Shape Exporter Enhancements
There are a number of enhancements to the Nuke exporter for proper rendering 

of shapes, feathers and mocha perspective transformations in addition to 

increased accuracy. Also, Alpha values can be repeated in the RGB channels 

as an export option.

Notes: 

1 If there are no mocha perspective transformations, the handles of feathers and 
open shapes will render correctly in Nuke. 

2 If there are mocha perspective transformations:

• The output is correct but feather and open shape handles will appear to be very 
long. This is a Nuke user interface bug.

• In Nuke, if a feather point is added using the E key, the feather point will be far 
away and have to be dragged back to the desired location. This is another Nuke 
user interface bug.

Read formats.xml From Outside Of Resources
A SFX_FORMATS_PATH environment variable was added which can be the 

complete path to an xml file containing the desired formats.
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Scripting
Create And Select A New Project Via Scripting
Added a way to create a new project with a complete bundle name and then 

have the UI select it.

syntax:
project = Project(bundle_path)
activate(project)
project.save() 

object_renamed hook
For when objects get renamed, added object_renamed hook and the callback 

gets the object.

Shape Import Using Python
Shapes can now be imported using Python.

Timeline Frame Range
The Timeline now always shows the full session range with the work range 

displayed using a gray bar at the top of the Timeline. The work range can 

quickly be adjusted by: 

• Ctrl-drag the ends of the work range bar to change the start and end.

• Ctrl-drag the work range bar to slide it forward and back while maintaining the 
duration.

• To center the timeline on the current frame, click the top left corner of the Timeline 
above the object labels.

Timeline Markers
The Timeline context menu now has a Marker option which allows for the 

creation, editing or deletion of markers. Timeline Markers are a handy way of 

placing notes at specific points in time. Markers are displayed as light blue 

squares at the top of the Timeline.

When you right-click in the Timeline and select Marker > Create/Edit, a dialog 

box opens where you can enter, change, or clear text. When you enter text and 

click OK, a marker is displayed.
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Visual Warning for Paint > Clone > Grade/Filter Controls
The Paint > Clone > Grade and Filter controls are hidden in tabs so we have 

added a visual indicator in the tab if the controls have been modified.

Changes

Clone Reset Behavior
Previously, Clone Reset only reset the Transform controls. Now, all clone 

parameters, including Grade and Filter parameters are reset.

Composite Resolution
Previously, the DOD (Domain of Definition) was determined by the background 

clip of a composite. Now, the union of the foreground and background 

determines the DOD.

Point Tracker > Smooth Behavior
In the Point Tracker, the Smooth option will no longer be available if there are 

no visible selected trackers. Smoothing will only smooth visible trackers.

Point Trackers Within Layers
Silhouette now allows Point Trackers to be added and tracked within layers.

Bug Fixes

Alpha Overlay Was Affected By OCIO Viewer Controls
Alpha and color overlay are no longer affected by the viewer OCIO controls.

Cache Display Not Working - Windows
The Cache Display would not work on Windows in certain situations.

Import Footage With No Project Crash
When there was no project, it was possible to double-click in the Sources 

window to import footage which caused a crash.

Missing Frames - Macintosh
In some cases, frames would display as black after opening a project.
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Nuke Tracker Importer Problem
mocha tracks pasted into the Nuke tracker did not import into Silhouette.

Panning and Beeping
Holding the Space key and panning could cause beeps to occur during auto-

repeat.

Session > New Session Crash
When there was no project, it was possible to select Session > New Session 

which caused a crash.

Tablet Problems - Macintosh
Some Mac users were experiencing strange tablet behavior in the Roto node.

Text Box Focus Behavior 
If the cursor was in a text field and the cursor was moved into any major view, 

it would steal the focus. You know have to press the Tab key to leave the focus 

of a text field. 

Timeline Keyframe Paste Problem
Pasting keyframes from two shapes did not paste the proper keyframes into the 

first shape.

Timeline Not Displaying Tracks At Startup
In some instances, the Timeline did not display tracks at startup.

zMatte Crops Output When Deartifact Was Enabled
zMatte’s Composite output was cropped to the foreground when Deartifact was 

enabled.
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 WHAT’S NEW IN 6.0.33

Features

EXR Multi-View
If the EXR output extension is sxr, the EXR module will write out a multi-view 

file. Otherwise, it writes a multi-part file. 

Note: This will only work if there are only left and right views.

OFX
Silhouette now supports RE:Vision Effects Twixtor and ReelSmart Motion Blur 

OFX plug-ins.

Roto Node > Color Comp View Mode
A Color Comp view mode has been added to the Roto node. The shortcut key 

is 4.

Save Paint History With Auto-Saves
The Paint history is now saved along with the auto-saves. A rotating list of 

backup paint histories are stored in the respective paint data directory so you 

can choose the one you want.

View Paint (Shift-0)
When View > Paint is selected in the Paint node, Shift-0 displays paint strokes 

over black.

Changes

Linux - Python 2.7
Silhouette v6 requires Python 2.7 with UCS4 support. If you are running an 

older distribution, we have packaged Python 2.7 as a convenience. To enable 

the internal Python (i.e. if you don’t already have Python 2.7), uncomment the 

PYTHONHOME line in the run.sh script.
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Fixed Bugs

DVE Crash
The Transform node could crash in when used in conjunction with certain 

nodes.

EXR Compression Parameter Display Problem
When you added an Output node, the custom module parameters were not 

created until you actually selected the module from the list again.

Paint and Match Node Crash
Silhouette would crash if a Match node was used before the Paint node.

Pasted Nodes Did Not Get A New Label
Pasted nodes had the same name as the original. They are now incremented 

by 1.

Render - Output Directory Variables
Variables were not expanded in the path portion of the output path. For 

example, an output path of "$(HOME)/output" was not properly expanded with 

the HOME variable replacement.

Scripting
Cloning a Project Returned The Wrong Type
Cloning a project via scripting returned an Image object instead of a Project 

object.

Object_Created Did Not Get Proper Type
In the object_created hook, the created object had the base Object type but not 

the subclass type.

User-Defined Properties Should Remember Their Positions
If user-defined properties were inserted between default properties, they 

loaded back in at the end.
lhouette v6 What’s New



• 

What’s New in 6.0.28  9 

• 
• 
• 
•
•
•

 WHAT’S NEW IN 6.0.28

Fixed Bugs

Nuke 10 Tracker Import
Nuke 10 trackers will now import into Silhouette. In addition, trackers with a 

start frame other than 1 will now import into Silhouette as long as the Silhouette 

start frame matches the Nuke start frame. 

Output Multi-Part Node Missing on Windows
A recent update mistakenly removed the Output Multi-Part node on the 

Windows version.

Temporary Paint File
We create a temporary paint file called sfxpaint.dat used for undo events. The 

file is only deleted when Silhouette is closed and could get quite large. In 

addition to deleting the temporary paint file when Silhouette is closed, it is also 

now deleted when the project is switched.
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 WHAT’S NEW IN 6.0.27

Fixed Bugs

Renders 1 Frame Short
A recent update caused the last frame of a sequence to not be rendered. This 

also affected rendering the current frame.
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 WHAT’S NEW IN 6.0.26

Features

Scriptable Custom Button Property
A custom button property can now be added with a script callback function.

Changes

Scripting -> object.properties Attribute Is Now A Normal 
Python dictionary

Any scripts that iterated over object properties should be updated.

Fixed Bugs

Holdout Composite Crash
Holdout Composite would crash if only one input was connected.

Linux Node Crashes
A compiler error in a recent Linux update caused crashes with the following 

nodes: Bump Distort, Chromatic Aberration, Keystone, Lens Distortion, Morph. 

Roto Blend, Scatter and Turb Distort.

Renderer Did Not Support A Specific Frame Set
The command-line renderer -range option did not work. 

Scripting
Added Proper Indentation in Code Editor
Tab and Shift-Tab now properly indent (and un-indent) blocks of code.

Adding An Empty Group Property To A Node Caused A Crash
When adding a custom group property with no children to a node, the property 

view crashed.
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node.properties Did Not Act Like A Real Dictionary
We originally created are own dictionary interface to the internal prop-list, but 

instead rewrote it to use a normal Python Dict and now it behaves as expected.

X-Ray Render Problem
The X-Ray node was not rendering correctly.
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 WHAT’S NEW IN 6.0.25

Features

Linearize Images In Mocha Pro
If you are using rec709 8-bit images, enable the Mocha > Linearize Images In 

Mocha Pro preference and they will look correct in the Mocha user interface.

Fixed Bugs

EXR Alpha Automatically Opaque
EXR files without an Alpha channel automatically had a an opaque Alpha 

channel once imported into Silhouette.

Render Options > Output Start Frame Not Obeyed
The Output Start Frame number was not obeyed in some cases.
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 WHAT’S NEW IN 6.0.24

Fixed Bugs

Roto - Nuke 9+ Export Problem With Nested Transforms
In some cases, nested transforms were not being exported correctly to Nuke.
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 WHAT’S NEW IN 6.0.23

Fixed Bugs

Roto > Input Alpha and Motion Blur Crash
Fixed an issue that caused sources with input alpha to crash when using Roto 

shapes with Motion Blur.
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 WHAT’S NEW IN 6.0.22

Features

mocha Pro OFX v5.2.1 Plug-In Compatibility
Silhouette is now compatible with the mocha Pro OFX v5.2.1 plug-in.

Fixed Bugs

Linux Centos 7 Error
On some Linux Centos 7 systems, Silhouette would fail to start with the 

following error: The application failed to start because it could not find or load 

the qt platform plugin xcb.

Roto - Copy/Paste Order Of Roto Objects Not As Expected
In certain projects, the order of pasted objects did not match the original 

selection.

Roto - Input Alpha Motion Blur Problem
The input alpha was not computed properly when Motion Blur was enabled and 

caused corruption.
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 WHAT’S NEW IN 6.0.21

Features

User Interface > Trees > Connections Preference
A User > Interface > Trees > Connections preference with Curved and Straight 

options was added.

Fixed Bugs

Output Start Frame Wrong in Render Window
A modified Output Start Frame in the Render window was off by one the next 

time you opened the Render window.

sfxcmd -info Crash
The sfxcmd -info command-line could crash when running scripts.

Undo Crash With Non-Keyframed Splines - Linux
Fixed a Linux compiler bug which would cause a crash when undoing a change 

to a non-keyframed spline.

Copy Node Naming Error
Copying nodes resulted in both nodes getting the same name.
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 WHAT’S NEW IN 6.0.20

Features

Action > Time > Shift Source Time
A source sequence can be shifted in time by inputing both the source frame and 

the destination session frame. This automatically calculates and sets the 

Source node’s Time Shift parameter.

Render Only Alpha Parts to EXR
Silhouette now supports rendering alpha only multi-part files.

Scripting
Add User-Defined Property Groups
Property groups previously could not be defined. A Property with no value is 

now a group. Info dictionary attributes are "expand" (True|False). To put a 

property into the group, prefix the property name with <group_name> and dot. 

For example, group.property.

Order Actions
You can now control the order of Actions and Action menus. Action has a new 

"order" argument that can be set to an index. The default is -1, which means to 

use alphabetic order (the default). Actions can also be placed in the File and 

Edit menus by specifying the optional "root" argument with the string "File" or 

"Edit".
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Fixed Bugs

EXR Render Crash - EXR Parts With Same Name
SFX crashed when trying to render multiple EXR parts with the same name.

Mocha Floating License Not Returned Until Exit
Instead of checking in a mocha floating license when leaving the mocha tab, it 

was not returned until Silhouette was exited.

Roto Node > Blur Crash
Silhouette would crash when the Roto node’s blur was adjusted.
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 WHAT’S NEW IN 6.0

Silhouette v6 is a fully featured, GPU accelerated compositing system. Its 

standout features are award winning rotoscoping and non-destructive paint as 

well as keying, matting, warping, morphing, and a total of 136 different nodes-

-all stereo enabled. 

Features

Trees and Nodes
Trees
The power of Silhouette lies in the Trees window where your effects are built. 

A tree is a series of clips and nodes, such as color correction, image processing 

and composite nodes, plugged together to create the desired effect. The tree 

is grown by adding clips and nodes in any order. The ability to view any node 

while editing another allows for very complex composites that can be set up 

and rendered in one pass.

Nodes
Silhouette is now a GPU accelerated node based system with 137 different 

nodes used for various functions. Located in the Nodes tab at the bottom of the 

screen, nodes are grouped into the following categories: 

Color
Black and White, Chromatic Aberration, Color Correct, Defringe, Develop, High 

Contrast, Invert, Kelvin, Low Contrast, Match, Polarizer, Printer Points, 

Selective Color Correct, Shadows/Highlights, Telecine, Tone Adjust, Vignette.

Composite
Alpha to Color, Color Paste, Composite, Copy, Drop Shadow, Edge Composite, 

Fade Color, Grain Composite, Holdout Composite, Light Wrap, Math 

Composite, Mix, Non-Additive Mix, Optical Dissolve, Premultiply, Slap Comp, 

Swap Channels, Switch Matte, Unpremultiply.
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Diffusion
Center Spot, Depth of Field, Diffusion, Double Fog, Fog, Halo, Net, Rack 

Focus, Silk, Split Field.

Filter
Blur, Bump Shade, Deartifact, Deband, Deblock, Deflicker, Defog, Degrain, 

Despeckle, Detail, Displace, Edge Detect, Grain, Mosaic, Scatter, Scratch, 

Sharpen.

Film Lab
Bleach Bypass, Cross Processing, Film Stocks, Grunge, Overexpose, Three 

Strip, Two Strip.

Image
Checkerboard, Color, Color Bars, Depth, Fractal Noise, Grid, Linear Gradient, 

Merge Views, Null, Output, Output Multi-Part, Paint, Radial Gradient, Roto, 

Roto Blend, Split Views.

Key
Color Suppress, Difference Matte, Matte Repair, Power Matte, Screen 

Smoother, zMatte.

Light
Glow, Glow Darks, Glow Edges, Rays, Reflector, Relight, Star, Streaks.

Silhouette
Depth, Morph, Output, Output Multi-Part, Paint, Power Matte, Roto, Roto 

Blend, zMatte.

Special Effects
Cartoon, Color Infrared, Color Shadow, Day for Night, Harris Shutter, Infrared, 

Looks, Night Vision, Pastel, Pencil, Texture, X-Ray.

Time
Retime, Time Blur.

Tints
Color Gradient, Color Spot, Colorize Channel, Colorize Gradient, Dual 

Gradient, ND Gradient, Photographic, Radial Tint, Split Tone, Sunset, Tint.
Silhouette v6 What’s New    
• 
• 
•
•
•



   Si

22 What’s New in 6.0

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Transform
Camera Shake, Crop, Flip, Flop, Keystone, Resize, Tracker, Transform.

Warp
Bump Distort, Lens Distortion, Morph, Turb Distort.

Presets
Visual presets for most nodes.

Featured Nodes
Roto

Feathering
Open Shape Feathering

Opens shapes can now be feathered.

Per-Point Feathering

Feathering is now implemented for every point in the shape so as to be 

compatible with Nuke.

Open Shape Cap Style
A Cap Style parameter has been added for open shapes. You can choose from 

Flat or Round end cap styles.

Nuke 9+ Exporter
Silhouette will now export open/closed shapes, the shape feather, opacity, 

blend mode, invert, motion blur, outline color, fill color, shape blur (inner and 

outer blur only), and visibility. The layer’s blur, visibility and motion blur are also 

exported in addition to the node blur. You can optionally fully bake shape and 

transform data, convert opacity to Nuke Lifetime, and export the Silhouette 

project name.

Render Shape Outlines
Shapes in the Roto node can now be rendered as outlines over the image.

Paint

Speed
Switching frames after painting is now instantaneous, even with large images, 

as a result of the frames being saved in a background thread.
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Trackers
Paint can now utilize Trackers from any node that produces them. Just connect 

the Objects output of any node that produces Trackers into the Paint node’s 

transform input (colored yellow) located at the top right of the node. You then 

select which tracked layer to use from the Paint tab’s Transform pop-up menu.

ROI Compatibility
Paint is now compatible with ROI (Region of Interest) so you can paint on a 

much smaller area of a larger image.

Clone
Blur Aspect

Allows differing amounts of blur on the X and Y axis. Blur Aspect is along the X 

axis, so setting the aspect to 2 would be twice as much blur horizontally than 

vertically.

Filtering

The Clone filtering has been improved for all filtering methods.

On-Screen Controls - Corner-Pin

The mouse, pen/tablet or Arrow keys can now all be used to move corner-pin 

points after first selecting them with the Ctrl(Win)/Cmd(Mac)-1,2,3 or 4 keys 

corresponding to the top left, top right, bottom right and bottom left corner 

points. Pressing Ctrl(Win)/Cmd(Mac)-1,2,3 or 4 a second time deactivates the 

mode. This is useful when Interactive mode is disabled or when you are 

zoomed into the image.

Obey Matte On All Inputs
The alpha of all incoming inputs can be used as an Obey Matte source.

Drag Brush - Alpha Behavior
The Drag brush now draws into the alpha channel identically to the RGB 

channels.

Depth
The Depth node contains a dedicated tool set for creating depth channels.
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Shape Gradients
Silhouette's industry leading rotoscoping and shape tools have expanded 

functionality in the Depth node. New shape parameters include depth and 

gradient control.

Depth Tools
Alongside the powerful rotoscoping tools, the Depth node adds a number of 

depth tools that make quick work of common depth map tasks. The time-saving 

tools include Constant, Horizon, Ramp, Hall, Tunnel and an Alpha object which 

converts the alpha channel hooked into the Depth node’s Alpha inputs into a 

depth map.

Depth Preview
The Depth Preview window in the Depth node displays a 3D view of the depth 

map. It is very useful for visualizing the depth and placement of objects in 3D 

space. Clicking and dragging will move the image around in a perspective view.

Roto Blend
The Roto Blend node smoothly blends the opacity of shapes together. This is 

very useful for creating depth mattes which can then be further manipulated in 

the Depth node.

Tracker
Previously, the Tracker tool was only available in certain nodes. Now, a new 

Tracker node can be plugged into other nodes that contain trackable items so 

that they can directly make use of transformed layers.

OFX
OFX plug-ins are now supported. At the current time, Genarts Sapphire has 

been qualified to run in Silhouette.

Region of Interest
The ROI (Region of Interest) tool crops the image in the Viewer to a user 

defined size and can be animated. This is especially useful when you only need 

to work within a smaller region of a larger image as it will use less memory and 

process faster. If expanded, the ROI will display overscan pixels which can then 

be manipulated.
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Resolution Independence
Although Silhouette Sessions are a fixed size, sources of different resolutions 

can be used. Overscan areas of sources larger than the Session are never 

clipped and are accessible with either a Transform node or expanding the ROI 

(Region of Interest).

Actions
Batch > Rename
Renames selected objects to match the first selected object.

Keyframes

Select All
Selects all keyframes.

Select Layer
Selects all layer keyframes.

Select Shape
Selects all shape keyframes.

Select Tracker
Selects all tracker keyframes.

Select > Single Point Shapes
Selects single point shapes.

Preload Frames
Source frames are automatically cached in a background thread. The amount 

of frames preloaded is controlled by a Cache > Preload Frames preference.

EXR Enhancements
• EXR multi-part files can be rendered using the Output Multi-Part node.

• The EXR data window is fully supported and the ROI (Region of Interest) is saved 
as an output EXR data window.

• When creating a new session based on an EXR file, the session size will use the 
display window but the data window will appear in the proper place, and overscan 
is available.

• The metadata contained in EXR files is now passed through to the rendered file.
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Scripting
There are a number of scripting changes in v6. See the Scripting Guide for 

what's new.

User Interface
Curve Editor
The Curve Editor is a view mode in the Timeline that allows you to work with 

keyframe animations expressed as curves on a graph. It lets you visualize the 

interpolation of the animation.

Preferences

Cache > Preload Frames
Controls how many source frames are preloaded into the cache.

Paint > Default Source
Sets the clone source default.

Shape > Hide Outlines During Edit
When activated, the shape outline is hidden when editing.

User Interface > Colored Timeline Tracks
Colors the timeline tracks the same as the Roto node’s shape colors.

Retina Support
The Silhouette user interface has been upgraded with Retina display support 

for Macintosh systems.

Snapshot
Captures the image in the Viewer so that it can be compared with other nodes 

or Viewer modes using Toggle Snapshot, Vertical Split, and Horizontal Split 

snapshot modes.

Timeline > Select All Keys
When hovering over a track, Select All Keys will select all keyframes for that 

track. If not over a track (empty area), it will select all keyframes in the timeline.
lhouette v6 What’s New
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Workspaces
Custom workspaces can be saved/deleted through the new Window > 

Workspace menu.

Changes

Composite > Background Color Preference Removed
The Composite > Background Color preference has been removed. Now, if you 

use only one input of a multi-input composite node and select View > 

Composite, the background color will default to black.

Crop Node Now ROI
The Crop node has been converted to a ROI (Region of Interest) Viewer tool.

Disk Cache Removed
As Silhouette has evolved to a more complex node based system, disk caching 

has been removed and replaced with a Cache > Preload Frames feature. See 

the features section for more information.

Feather Tool Removed
The Silhouette v1-v5 Feather tool is no longer visible in the Toolbar as 

feathering now takes place in the Reshape tool. Projects with Silhouette v1-v5 

feathering can be loaded and the old Feather tool will appear.

The feathering method used in Silhouette v1-v5 can still be used by enabling 

the Shape > Enable Legacy Feathering preference. This will force the feather 

tool to appear in the Toolbar. However, you will not be able to export the 

feathering data to Nuke as it is not compatible.

Multiple Shape Selection & Bounding Boxes
Previously, the bounding boxes of all shapes in a multi-shape selection were 

displayed in Transform mode and was distracting. Now, only the combined 

bounding box is displayed.

Node Inputs
The Inputs menu in the Viewer has been removed since node inputs are now 

hooked up within the Trees window.
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Node Outputs
Some nodes have multiple outputs. For instance, the Roto node has Output, 

Composite, and Channels outputs and the Paint node has Output and Paint 

Only outputs.

Nuke Tracker Import
Silhouette now imports Nuke 8 and above trackers.

Project Folder and Filename
The project folder and filename can now be named identically by setting the 

following environment variable: SFX_PROJECT_IS_BUNDLE=1

Quicktime
Quicktime is no longer supported.

Render Options Window / Output Node
The Output node is where you now specify the file name, file type, and 

channels to render. The Render Options window only deals with which nodes 

to render, frame range, resolution, field handling and whether to apply a region 

of interest.

Render Shapes to Channels
The Render Shapes to Channels action has been removed as it can be 

achieved by using the Roto node’s Channels output.

Session Creation
• The New Session dialog no longer has the ability to choose which nodes to add. 

The Nodes window is where you select the nodes you will be working with.

• There is a Session > Default Type preference that lets you choose from 
Composite, Roto and Paint session types. When set to Roto or Paint, a Roto or 
Paint node is automatically added when creating a session. With Composite 
selected, no nodes are added by default. The session is ready for you to add 
whatever nodes you like.

• Whichever type of new Session is created, an Output node is always automatically 
added and it determines the file format, file name, disk storage location, and 
channels to be rendered.
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Source Settings
Source settings such as field handling are now edited in the Object window. 

Click on a clip in the Sources window to display its parameters. 

Sources Window
The Project window has been replaced with a Sources window where source 

media can be displayed in a thumbnail format.

Stabilize and Shape Bounding Box Points Appearance
The shape bounding box points nested within layers with extreme transforms 

now appear normal when Viewer > Stabilize is enabled.

S3D Node Removed
The S3D node has been removed and replaced with the Depth node.
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